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https://sunray.sakura.ne.jp/sub_seminar.html 2024.11.29

IOT 実習セミナー （ Arduino UNO R4 WiFi ）

開発環境構築手順

手持ちの PCに下記 ３つのアプリをインストールしてください。

１．Arduino IDE

https://www.arduino.cc/en/Main/Software

より ダウンロード 今（241017）の最新バージョンは ArduinoIDE 2.3.3

２．TeraTerm

https://forest.watch.impress.co.jp/library/software/utf8teraterm/

３．Visual Studio Code

https://code.visualstudio.com/download

インストール中の設定問い合わせは、こだわりがない限りデフォルトのままで OKです。

これを選択（ win10、win11 )

これをクリックして

ダウンロード、インストール

これをクリックして

ダウンロード、インストール
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【Arduino UNO R4 WiFi を使用する為の設定】

Arduino IDE を起動する。

「ボードマネージャ」を選択し ［Arduino UNO R4 Boards］のインストール

［Arduino UNO R4 Boards］ の設定

①クリック

して選択

②この文字入力（候補の絞り込み）

③クリックしてインストール

①クリック

②クリック

③選択

④クリック

⑤確認
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はじめの一歩

１．パソコンと Arduino を USB ケーブルで繋いでみる。

COMポート番号の確認

デバイスマネージャーから

２．コンパイルのテスト

Arduino IDE を起動する。

File →New Sketch

Verify（検証）をクリックしてコンパイルがエラーなく完了するか確認する。

COM3 この番号を覚えておく。

Upload(書込み)Verify（検証）

[デバイス マネージャー]を出すには

Windows10、11：

画面左下の （スタートボタン）を右クリックし、表示された「クイック リンク」メニューから

[デバイス マネージャー]をクリックします。
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３．Arduino Boaｒd に書き込む

設定の確認

Tools→Board”Arduino UNO R4 WiFi”

Port”COM3”

Upload(書込み)

コンパイル後 100% 書き込みが完了する。

テストスケッチの作成

File→Save As...

名前を「 sketch_Test0-IO 」 に変更して保存する。

「検証」と「書き込み」がエラーなく終了することを確認する。

打ち込む

打ち込む
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作成したスケッチの記憶場所は？

File →Preferences（環境設定） Preferences の直訳は「好み」という意味

次のスケッチを作るために名前を「 sketch_Test１_Serial 」として保存

シリアルポートを使う。

書き込み 実行後 Serial Monitor をクリックする。

スケッチはここに保存される。

日本語の選択ができる。
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シリアルモニタをクリックして思い通りの表示が出るか確認する。

文字化けしたとき、ボーレートは合っているか？

このスケッチのデータはここにある。

https://sunray.sakura.ne.jp/Test1-Serial.txt

ここで開いても日本語が文字化けするので以下の方法で

「 制御の学習 」のページに戻る。

次ページの様にブレッドボードにタクトスイッチとLEDの配線を行ってプログラムの検証を行

う。

注意：配線時は必ず電源は抜くこと、電源を入れる時は再度配線チェック

Serial Monitor

①右クリック

②名前を付けてリンクを保存

③そのファイルをメモ帳で開く

④テキスト全てを Arduino スケッチに

コピー＆ペーストする。
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ブレッドボード配線

「AUTODESK Tinkercad」 で作成

* IO 出力電流には注意が必要

CPU スペック確認要

LED

SW

プルアップ、プルダウンとは？

1ｋ

なし

10ｋ

2

-3

-11

DHT11

①5V

②DATA

③NC

④GND

①—②プルアップ 4.7ｋ
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日本アマチュア無線連盟の HPから 抵抗のカラーコード

LED の仕様 順電圧 逆電圧について

マルツ HPから

https://www.marutsu.co.jp/pc/static/large_order/led?srsltid=AfmBOoofhGhGOesLnB43jqx

AxBXsfDVKDIQj6bkP0wWiLpLEmxDH0NPT

ブレッドボードの内部配線
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下記スケッチ（WiFiServer)の検証をしましょう。

https://sunray.sakura.ne.jp/Test2-WiFiServer.txt

・ IP アドレス「Internet Protocol Address」とは

他社参考 HP： https://www.cman.jp/network/term/ip/

・ DHCP（Dynamic Host Configuration Protocol）

ネットワーク接続に必要な設定（IP アドレス等）を自動的に行うプロトコル

自分の PC に割り当てられた IP アドレスはコマンドプロンプトから「 ipconfig 」

コマンドプロンプトで実行は、

「サブネットマスク」とは 他社 HP： https://www.cman.jp/network/term/subnet/

「デフォルトゲートウェイ」は ここでは、このセンターのルーターになる。

・ Ping

ping（ピン、ピング）を打つとは、ネットワーク上で特定の機器と通信できるかどうかを確

認するコマンドを実行すること。

参考 HP： https://ja.wikipedia.org/wiki/Ping

Arduino シリアルモニタ

Test2-WiFiServer を実行した時の

IP アドレス

ｃmd と入力し検索 実行

ping
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//IPAddress (74,125,232,128); // numeric IP for Google (no DNS)

"www.google.com"; // name address for Google (using DNS)

DNS(Domain Name System) DNS で検索

>ping www.google.com

>ping 74.125.232.128 ？

Google IP アドレスで検索

・ Tracert

指定先までの通信経路がわかる。

参考 HP：https://ja.wikipedia.org/wiki/Traceroute

tracert
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ターミナルアプリ TeraTerm を使用する。

「設定」→ 「TCP/IP」 → 「自動的にウインドウを閉じる」のチェックを外す。

新しい接続

TCP/IP インターネットで Web ページを見るときに利用するプロトコル

TCP（Transmission Control Protocol）

IP（Internet Protocol）

フリー百科事典『ウィキペディア（Wikipedia）から

Telnet？

https://ja.wikipedia.org/wiki/Telnet

SSH？

https://ja.wikipedia.org/wiki/Secure_Shell

TCP ポート番号？

https://ja.wikipedia.org/wiki/TCP%E3%82%84UDP%E3%81%AB%E3%81%8A%E3%81%91%E3%82

%8B%E3%83%9D%E3%83%BC%E3%83%88%E7%95%AA%E5%8F%B7%E3%81%AE%E4%B8%80%E8%A

6%A7

他社サイト SSH SSL とは

SSH とは。通信を暗号化する仕組み、SSL との違いを徹底解説 | Winserver のススメ

TCP/IP？

Telnet？

SSH？ SSL？

TCP ポート番号？
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TeraTermからの信号で LED OnOff する。

https://sunray.sakura.ne.jp/Test3-WiFiServer_input.txt

温湿度センサー（DHT11）を使う。

https://sunray.sakura.ne.jp/Test4-WiFiServer_DHT11.txt

コンパイルすると ERRORが発生する。ヘッダーファイルがないでー

Library 「DHT sensor library」のインストール

#include <DHT.h>

参考

#include <stdio.h> //C コンパイルシステムに含まれる標準ヘッダーファイルをインクルード

#include "header.h" //ユーザーが自分のディレクトリに格納したヘッダーファイル

DHT11 と入力して

DHT sensor library を探す。

library
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公式サイト：Arduino uno R4 Wifi ネットワーク例

https://docs.arduino.cc/tutorials/uno-r4-wifi/wifi-examples/

アクセスポイントモード（AP）、ステーションモードとは？

DHT11 を使った参考 HP DHT11 で検索したらいっぱい出てくる。

https://stemship.com/xbee-thermosensor1/

https://docs.sunfounder.com/projects/ultimate-sensor-kit/ja/latest/components_basic/1

2-component_dht11.html

公式サイトから Example(ChatServer) Teraterm で検証できる。

https://docs.arduino.cc/tutorials/uno-r4-wifi/wifi-examples/#wi-fi-chat-ser

ver
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2 日目

Arduino uno R4 Wifi ハード説明

https://docs.arduino.cc/hardware/uno-r4-wifi/

Datasheet 2/46 から

マイコン MCU(Micro Controller Unit)：ルネサス RA4M1

詳細は[ R7FA4M1AB3CFM ] で検索して

30/131

スレッショルド電圧

TTL レベル、CMOS レベル

TTL レベル CMOS レベル

入力電圧 High レベル ２．０V 以上 ０．７ ｘ Ｖｄｄ 以上

入力電圧 Low レベル ０．８V 以下 ０．２ ｘ Ｖｄｄ 以下

出力電圧 High レベル ２．４V 以上 Ｖｄｄ － ０．８Ｖ 以上

出力電圧 Low レベル ０．４V 以下 ０．４V 以下

ＩＣ、センサー等を繋ぐときはマニュアルの詳細確認が必要

トレラント 5V 3.3V の混在
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31/131

出力電流に注意

LED接続時の電流は

WiFi：ESP32-S3-MINI-1-N8

ESP32で検索

9/46 部品配置 Front View

Schematics（回路図）5V 3.3V 混在

ルネサスのページ

https://www.renesas.com/ja/products/microcontrollers-microprocessors/ra-cortex-m-m

cus/ra-partners/arduino-uno-r4

1ｋ

OUT 5V

順電圧 2.1V LED により

電流値は

（5-2.1）v / 1k = ２．９ｍA
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ブラウザからの操作

公式サイトから Example(Simple Webserver)の確認

https://docs.arduino.cc/tutorials/uno-r4-wifi/wifi-examples/#simple-webserver

File → New Sketch

公式 HPのスケッチをコピー＆ペースト

コンパイルしても通らない。

ヘッダーファイル arduino_secrets.h の追加。 右端 ・・・ クリック New Tab

名前を付けて保存 Test10-SimpleWebserver

https://sunray.sakura.ne.jp/Test10-SimpleWebserver.txt

コンパイル、書き込み

シリアルモニタには

ブラウザ「Google Chrome」で操作

http：//192.168.0.16

port 番号 ８０：

サーバーアプリケーションによりポート番号が決まっている。

２３：telnet

８０：http

４４３：https
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スマホでも確認できる。

サーバー へ リクエス
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<p>タグ 段落を作る。開始タグ<p>～終了タグ</p>が 1 つの段落

<a>タグ リンクの出発点や到達点を指定するタグ、href 属性でリンク先を指定

<br>タグ 改行

client.print("<p style=\"font-size:7vw;\">Click <a href=\"/H\">here</a> turn the LED on<br></p>");

client.print("<p style=\"font-size:7vw;\">Click <a href=\"/L\">here</a> turn the LED off<br></p>");

生文字列では

<p style="font-size:7vw;">Click <a href="/H">here</a> turn the LED on<br></p>

<p style="font-size:7vw;">Click <a href="/L">here</a> turn the LED off<br></p>

生文字列リテラルを使う。

参考サイト： https://cpprefjp.github.io/lang/cpp11/raw_string_literals.html

https://sunray.sakura.ne.jp/Test10a-SimpleWebserver.txt

次は HTML らしくした。

https://sunray.sakura.ne.jp/Test10b-SimpleWebserver.txt

湿度、温度を表示するスケッチ

https://docs.arduino.cc/tutorials/uno-r4-wifi/wifi-examples/#wi-fi-web-server

この公式サイトのサンプルを修正して

https://sunray.sakura.ne.jp/Test11-WiFiWebServer_DHT11.txt

Web サーバー

(Arduino)

クライアント
リクエストメッセージ

GET /H HTTP/1.1

Host: 192.168.0.6

レスポンスメッセージ

HTTP/1.1 200 OK

Content-type:text/html

<p style="font-size:7vw;">Click <a href="/H">here</a> turn the LED on<br></p>

<p style="font-size:7vw;">Click <a href="/L">here</a> turn the LED off<br></p>

バージョン

ステータスコード

説明

レスポンスヘッダー（コンテントタイプ）
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ChatGPT を利用して

https://sunray.sakura.ne.jp/Test12-chatGPT_OndoShitudoSwitchMomDisp.txt

ChatGPT：質問

１．Arduino Uno R4 WiFi を使って 温度と湿度を表示するスケッチを作って

２．WiFi ネットワーク環境にてブラウザで温度と湿度を表示したい

３．Web ページ部分を生文字列リテラルを使って整理したい

４．

１．JavaScript JSON について教えてください

２．Ajax について教えてください

３．

ChatGPT でトライ参考資料

https://sunray.sakura.ne.jp/Seminar_iot_ChatGPT1.pdf
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『 用語 』

・ TCP（Transmission Control Protocol）

インターネットの主要なプロトコル。 パケットの再送やエラー訂正などを行う機能を持って

いるため、確実性をもった通信を行う。

・ HTTP(Hypertext Transfer Protocol)

Web ブラウザと Web サーバー間で情報をやり取りするための通信規格

・ HTML(HyperText Markup Language)

WEB ページを作成するための言語

・ CSS（Cascading Style Sheets）

Web サイトの見た目を定義するためのプログラミング言語

・ HTML タグ

・ DHCP（Dynamic Host Configuration Protocol）

設定情報（IP アドレス等）を自動的に割り当てる機能

自分の PCの IP アドレス確認 コマンドプロンプトで「ipconfig」

・ http https の違い

・ JavaScript スクリプト言語

・ JSON「JavaScript Object Notation」

JavaScriptの書き方を元にしたデータ定義方法

他社参考 HP：https://products.sint.co.jp/topsic/blog/json

・ Ajax「Asynchronous JavaScript + XML」
JavaScript と XML を使って非同期にサーバとの間の通信を行う。
他社参考 HP：https://qiita.com/hisamura333/items/e3ea6ae549eb09b7efb9

IOT 参考サイト:

ワンボード/シングルボード PC

ESP32 による近距離無線通信の実験④ Wi-Fi 通信

http://marchan.e5.valueserver.jp/cabin/comp/index2.html

生文字列リテラル (Raw string literals)

R プレフィックスを付けた文字列リテラル内の丸カッコ( )で囲まれた部分は、エスケープシー

ケンスが無視される。

参考サイト:

https://cpprefjp.github.io/lang/cpp11/raw_string_literals.html
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Visual Studio Code

・拡張機能「Japanese Language Pack for Visual Studio Code」をインストールすることで日本

語に変更することができる。

・背景色を変える。

ファイル → ユーザ設定 → テーマ → 配色テーマ → ライトモダン、ダークモダン

①クリック

② japanese と入力し候補の絞り込み

③クリック

④インストール
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・ HTML(HyperText Markup Language)

WEB ページを作成するための言語

これを打ち込んで実行させてみよう。

本文：

<body>タグ と </body>タグ の間に書かれた

部分がブラウザのウインドウに表示される。

題名

<html>

<head>

<title>はじめての HTML</title>

</head>

<body>

<h1>こんにちは</h1>

</body>

</html>
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３日目

Google スプレッドシート（Spread Sheets）とは

無料で利用可能な表計算ソフト（Google アカウントを取得が必要）

データはオンライン（クラウド）上に保存、シートの共有が可能。

スマホでもアプリをインストールしておけば簡単な編集はできる。

ログイン方法

手順

１．Google アカウントにログインする。

２．Google ドライブに移動。

３．ドライブ画面左上 「＋新規」をクリック

① Google アプリ

クリック

② ドライブ

クリック
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４．「Google スプレッドシート」を選択

５．無題のスプレッドシートが作成される。（任意の）名前に変更

名前が変更された。

６．ウェブアプリの作成

拡張機能 → Apps Script をクリック

名前が変更された。

1 ここをクリック

2 Test20-SpreadSheet

に変更

① ここをクリック

② Test20-GasProject

に変更
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７．コードのところに以下の GAS コードをコピー＆ペースト

https://sunray.sakura.ne.jp/Test20-GasProject.txt

８．デプロイ （ 直訳：展開する 配置する ）

GAS(Google Apps Script ) で作成したアプリやツールを外部に公開するための URL を

生成する。

function doGet(e) {

const url = "https://docs.google.com/spreadsheets/????????;

const ss = SpreadsheetApp.openByUrl(url);

const sheet = ss.getSheets()[0];

const params = {

"timestamp": new Date(),

"temperature": e.parameter.temperature,

"humidity": e.parameter.humidity

};

sheet.appendRow(Object.values(params));

return ContentService.createTextOutput('sccess');

}

Google スレッドシートの URL に変更する。

クリック
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設定 → ウエブアプリ

デプロイの更新が始まる。（数１０秒）

①クリック

②クリック

①「全員」にする

②クリック
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クリック して「アクセスを承認」

クリック

クリック

このアプリは大丈夫か？と聞いてくる。
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まだ、このアプリが大丈夫か？と聞いてくる。

クリック

クリック
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数分かかる

これでウェブアプリが出来ました。

次にウェブアプリ GAS の確認

ブラウザの空 URL 欄に この URL をコピペすると

これを Arduino スケッチのソースコードに書き込む。

sccess が表示されれはOKです。
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９．Arduino スケッチ

https://sunray.sakura.ne.jp/Test20-spreatsheet_DHT11.txt

Arduino：コンパイル書き込み

１０．Google スプレッド：「 Test20-SpreadSheet 」を開く

日付時刻、温度、湿度データがセルに入ってくる。

グラフは列 A B C を選択し 挿入 → グラフ

ここにデブロイで生成された URL を書き込む。
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GAS（Google Apps Script) Google 社が提供するプログラミング言語

Gmail、Google スプレッド、Google カレンダー、Googleｇドライブ、Google 翻訳など

Google 社が提供するアプリケーション群をプログラミングにより連携して操作することが

出来る。（効率的に使うために）

・ JavaScript ベースの言語

・ Google 社のクライアントサーバー上で動作する。

バージョンアップは頻繁に行われている。

・ Excel を使うなら VBA、 Google スプレッドは GAS

GAS 解説の YouTube も沢山あります。

他社参考：https://www.youtube.com/watch?app=desktop&v=oISxaRU9ZZk&t=133s

実際 R4WiFi を IOT 端末として使うためには

・入出力関係

入力：一般制御で使われている２４V センターが使えるポートが必要

出力：容量の大きな装置を駆動させるポートが必要

・表示関係

R4WiFi が端末となり、電源のみ供給される。パソコンが繋がれていないので IP アドレ

スの確認が取れない。IP アドレスや動作状況等の表示器が必要

・プログラム関係

MCU:R7FA4M1AB3CFM の能力を１００％活かせるプログラムの作り方
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ホトカプラ TLP621

トランジスタ 2SC1815

１．出力

・アイソレート IO (isolate 分離）

Arduino の入出力は DC５V回路です。DC２４V（１２V）で動作させるにはアイソレート IO 回

路が必要です。

オープンコレクタ

この回路で良い

Arduino 許容出力電流に注意して決める。ホトカプラ変換効率にも注意
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負荷側 GND

５V回路

２４V

ホトカプラ TLP621

秋月 HP： https://akizukidenshi.com/catalog/g/g107442/

データシートもここにある。

トランジスタ 2SC1815

秋月 HP： https://akizukidenshi.com/catalog/g/g117089/

参考 秋月電子

ラズパイＰＬＣ用ＤＣ２４ＶアイソレートＩ／Ｏ基板パーツセット

https://akizukidenshi.com/catalog/g/gK-15645/

出力回路

入力回路

Arduino

入力ポート

トランジスタ出力

Arduino ０V

２４V 回路

モータ

負荷側 ２４V

Arduino ０V

５V 回路２４V 回路
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FET（2SK4017）を使って扇風機を駆動させる回路を作ってみよう。

（ Nch パワー MOSFET 60V5A )

秋月 HP： https://akizukidenshi.com/catalog/g/g107597/

ON 抵抗が低いので熱損失が少ない。

トランジスタ： 電流制御素子 ベース電流の大きさでコレクタ電流を制御 NPN と PNP がある

FET： 電圧制御素子 ゲート電圧の大きさでドレイン電流を制御 Nch と Pch がある

CQ出版社トランジスタ技術から引用
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参考：ロームのアプリケーションノートから

https://fscdn.rohm.com/jp/products/databook/applinote/ic/power/linear_regulator/lin

earreg_reverse_voltage_appli-j.pdf

Pch パワー FET を回路使った回路例 （こんなことも出来る。）

逆接防止ダイオードとして

電源出力

DC１２V～２４V

GND

ロードスイッチとして

電源入力

DC１２V～２４V
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1k

47k

1：G

オープンドレインの回路

3:S

2:D

配線図

スケッチの練習

１．SW を押したら扇風機を回す。

２．ブラウザから WiFi に繋いで扇風機を回す。

３．温度が上がったら扇風機を回す。

４．扇風機が回っているかをブラウザに表示する。

５．

LED

SW

①5V

②DATA

③NC

④GND

①—②プルアップ 4.7ｋ

③ソース

②ドレイン

①ゲート
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表示文字

スクロールスピード

IP アドレスを LED Matrix に表示する。

公式サイトから

https://docs.arduino.cc/tutorials/uno-r4-wifi/led-matrix/#resources

「Scrolling Text Example」 を試す。

ライブラリ： ArduinoGraphics をインストール

コンパイル、書き込み

このスケッチを参考にして、スケッチ Test12- での IPアドレスを LEDマトリクスに表示さ

せて下さい。

下記スケッチはとりあえず追加した。

https://sunray.sakura.ne.jp/Test12a-LedMatrixOndoShitudoSwitchMom.txt

ヒント Test12 から変更
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MCU の能力を１００％活かせるプログラムの作り方

・ 待ち時間をつくらない。

Iｆ文、While 文等で信号待ちをしない。

delay 文は使わない。タイマーまたはカウンタに置き換える。

・ MCU に負荷をかけない様に DMA を使う。

・ 割り込みを使う。イベント割り込み、タイマー割込み

私がやっているマルチタスク的なプログラム （常にサイクルは回っている。）

MCU（CPU）は逐次処理。

GPUは並列処理ができる。
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FspTimer.h

タイマー割り込み

参考サイト： https://workshop.aaa-plaza.net/archives/1658

delay( ) → millis( ) プログラムを起動してから経過した時間（ｍｓ）

公式サイト： https://docs.arduino.cc/built-in-examples/digital/BlinkWithoutDelay/

millis を使うと delay の様な待機時間がないので、次の処理が出来る。

「Arduino Uno R4」 はルネサスＡｒｍマイコンとなり、性能は格段に上がりました。

クロック 16ＭＨｚ → 48ＭＨｚ

フラシュメモリ：32ｋバイト → 256ｋバイト、

ＳＲＡＭ：2ｋバイト → 32ｋバイト

内蔵周辺装置（ペリフェラル）も充実し、かなり大きなプログラムも組めます。

ただ、今のデバッグ環境 printf 文では、デバッグの効率が上がらない。

ソースコードデバッグでブレークポイントを設定して、変数の値を確認できる環境が欲

しい。デバッグ環境も含めていろいろ挑戦してください。

私が使っている IDE（統合開発環境）はこんな感じ


